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Introduction

This manual describes how to connect the Display  and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below: 

1 System Configuration

This section lists the types of External 

Devices and SIO that you can connect.

"1 System Configuration" (page 3)

2 External Device Selection

Select a model (series) of the External 

Device and its connection method.

 

"2 External Device Selection" (page 12)

3 Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Communication Settings" (page 13)

4 Setup Items

This section describes communication 

setup items on the Display. Set the 

Display’s communication settings in GP  

Pro-EX or in offline mode.

"4 Setup Items" (page 59)

Operation
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1 System Configuration

The system configuration in the case when the External Device of YASKAWA Electric Corporation and the 

Display are connected is shown.

1.1 MP Series

 Connection Configuration

• 1:1 Connection

Series CPU Link I/F SIO Type Setting Example

MP2000

MP2300
MP2200

Ethernet port on 218IF-01 Ethernet (UDP)
"3.1 Setting Example 1" 
(page 13)

Ethernet port on 218IF-02 Ethernet (UDP)
"3.4 Setting Example 4" 
(page 22)

MP2310
MP2300S

Ethernet Connector on

CPU unit 
Ethernet (UDP)

"3.2 Setting Example 2" 
(page 16)

Ethernet port on 218IF-01 Ethernet (UDP)
"3.3 Setting Example 3" 
(page 19)

Ethernet port on 218IF-02 Ethernet (UDP)
"3.4 Setting Example 4" 
(page 22)

MP2400 Ethernet Connector on
CPU unit

Ethernet (UDP)
"3.2 Setting Example 2" 
(page 16)

MPU-01*1

*1 The firmware version of the MPU-01 to be supported is Ver. 2.86 or later.

Ethernet port on Main CPU*2

or 

Ethernet port on 218IF-01

*2 Please refer to the MPU-01 Manual for the supported list of Main CPUs.

Ethernet (UDP)
"3.12 Setting Example 
12" (page 43)

MP3000

CPU-201 Ethernet Connector on

CPU unit
Ethernet (UDP)

"3.9 Setting Example 9" 
(page 37)

CPU-201(SUB)*3

*3 The firmware version of the CPU-201 to be supported is Ver. 1.06 or later.

Ethernet Connector on Main 

CPU (CPU201)
Ethernet (UDP)

"3.15 Setting Example 
15" (page 51)

Ethernet Connector on 

CPU201(SUB)
Ethernet (UDP)

"3.9 Setting Example 9" 
(page 37)

Display

HUB

External Device

MP2000 (218IF-01) : 10BASE-T
MP3000 : 100BASE-T
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• 1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

• MPU-01

1:1 Connection

1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

• When connecting to the MPU-01 via the main CPU, do not make communications from two or 

more devices (e.g. Display and Ladder software) at the same time. If so, the MPU-01 may make no 

response. 

Display External Device

HUB

MP2000 (218IF-01) : 10BASE-T
MP3000 : 100BASE-T

External Device

Maximum number of External Devices: 64 *1

Main CPU MPU-01

Display

HUB

External Device

Display

HUB
Main CPU MPU-01

External Device

Main CPU MPU-01

External Device

Maximum number of External Devices: 64 *1
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• Sub CPU

1:1 Connection

1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

• A Sub CPU can be communicated via a Main CPU or in direct connection.

• When connecting to the Sub CPU via the main CPU, do not make communications from two or 

more devices (e.g. Display and Ladder software) at the same time. If so, the Sub CPU may make no 

response. 

Main CPU Sub CPU

Display

HUB

External Device

Display

HUB

Main CPU Sub CPU

External Device

Main CPU Sub CPU

External Device

Maximum number of External Devices: 64 *1
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1.2 Inverter Series

 Connection Configuration

• 1:1 Connection

• 1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

Series CPU*1

*1 The  symbol in the inverter model name represents the maximum applicable motor capacity and other               
specifications.

Link I/F Communication Setting Example

V1000
CIMR-VA
A

V1000 Option
MECHATROLINK-II
(SI-T3/V)

Ethernet (UDP) and 
MECHATROLINK-II

"3.10 Setting Example 10" 
(page 39)

A1000
CIMR-A
A

A1000 
MECHATROLINK-II
(SI-T3)

Ethernet (UDP) and 
MECHATROLINK-II

"3.11 Setting Example 11" 
(page 41)

MP series Inverter series

Display

HUB

External Device External Device

Between Display and MP series: Ethernet connection
Between MP series and Inverter series: MECHATROLINK connection

Between Display and MP series: Ethernet connection
Between MP series and Inverter series: MECHATROLINK connection
Between Inverter series  and Inverter series: MECHATROLINK connection

MP series

Inverter series Inverter series

Inverter series Inverter series

Display

HUB
External Device

External DeviceExternal Device

Maximum number of External Devices: 64 *1
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1.3 -V Series

 Connection Configuration

• 1:1 Connection

Series CPU Link I/F SIO Type Setting Example

-V Series
Rotary Motors
(M-II)

SGDV-
11


MECHATROLINK 
Communications Connectors 
(CN6A/CN6B)

Ethernet (UDP) and 
MECHATROLINK-II

"3.5 Setting Example 5" 
(page 25)

-V Series
Linear Motors
(M-II)

SGDV-
15


MECHATROLINK 
Communications Connectors 
(CN6A/CN6B)

Ethernet (UDP) and 
MECHATROLINK-II

"3.6 Setting Example 6" 
(page 28)

-V Series
Rotary Motors
(M-III)

SGDV-
21


MECHATROLINK 
Communications Connectors 
(CN6A/CN6B)

Ethernet (UDP) and 
MECHATROLINK-III

"3.7 Setting Example 7" 
(page 31)

MECHATROLINK 
Communications Connectors 
on MPU-01

Ethernet (UDP) and 
MECHATROLINK-III

"3.13 Setting Example 
13" (page 45)

MECHATROLINK 
Communications Connectors 
on Sub CPU

Ethernet (UDP) and 
MECHATROLINK-III

"3.16 Setting Example 
16" (page 53)

-V Series
Linear Motors
(M-III)

SGDV-
25


MECHATROLINK 
Communications Connectors 
(CN6A/CN6B)

Ethernet (UDP) and 
MECHATROLINK-III

"3.8 Setting Example 8" 
(page 34)

MECHATROLINK 
Communications Connectors 
on MPU-01

Ethernet (UDP) and 
MECHATROLINK-III

"3.14 Setting Example 
14" (page 48)

MECHATROLINK 
Communications Connectors 
on Sub CPU

Ethernet (UDP) and 
MECHATROLINK-III

"3.17 Setting Example 
17" (page 56)

MP series Σ-V series

Between Display and MP series: Ethernet connection
Between MP series and Σ-V series: MECHATROLINK connection

Display

HUB

External Device External Device
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• 1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

Between Display and MP series: Ethernet connection
Between MP series and Σ-V series: MECHATROLINK connection
Σ-V series  and Σ-V series: MECHATROLINK connection

MP series

Σ-V series Σ-V series

Σ-V series Σ-V series

Display

HUB
External Device

External DeviceExternal Device

External DeviceExternal Device

Maximum number of External Devices: 64 *1
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• Connection via MPU-01

1:1 Connection

1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

Σ-V series

Between Display and Main CPU: Ethernet connection
Between MPU-01 and Σ-V series: MECHATROLINK connection

Main CPU MPU-01

Display

HUB

External Device External Device

Between Display and Main CPU: Ethernet connection
Between MPU-01 and Σ-V series: MECHATROLINK connection
Σ-V series  and Σ-V series: MECHATROLINK connection

Main
CPU MPU-01MPU-01

Display

HUB

External Device

Σ-V series

External Device

Σ-V series

External Device

Σ-V series

External Device

Σ-V series

External Device

Maximum number of External Devices: 64 *1
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• Connection via Sub CPU

1:1 Connection

1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

Σ-V series

Between Display and Main CPU (or Sub CPU): Ethernet connection
Between Sub CPU and Σ-V series: MECHATROLINK connection

Main CPU Sub CPU

Display

HUB

External Device External Device

Between Display and Main CPU (or Sub CPU): Ethernet connection
Between SUB CPU and Σ-V series: MECHATROLINK connection
Σ-V series  and Σ-V series: MECHATROLINK connection

Main CPU Sub CPU

Display

HUB

External Device

Σ-V series

External Device

Σ-V series

External Device

Maximum number of External Devices: 64 *1
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• Connection via Sub CPU and MPU-01

1:1 Connection

1:n Connection

*1 When 33 or more External Devices are connected, it is necessary to check [Increase allowable number of 
Devices/PLCs].

"4.1 Setup Items in GP-Pro EX" (page 59)

Between Display and Main CPU: Ethernet connection
Between MPU-01 and Σ-V series: MECHATROLINK connection

Main
CPU MPU-01

Sub
CPU

Display

HUB

External Device

Σ-V series

External Device

Between Display and Main CPU: Ethernet connection
Between MPU-01 and Σ-V series: MECHATROLINK connection
Σ-V series  and Σ-V series: MECHATROLINK connection

Main
CPU MPU-01

Sub
CPU

Display

HUB

External Device

Σ-V series

External Device

Σ-V series

External Device

Maximum number of External Devices: 64 *1
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2 External Device Selection

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Use an integer from 1 to 4 to enter the number of Devices/PLCs to connect to the display.

Manufacturer
Select the manufacturer of the External Device to be connected. Select "YASKAWA 
Electric Corporation".

Series

Select a model (series) of the External Device to be connected and connection method. 
Select "MP/INVERTER/SERVO Ethernet".
Check the External Device which can be connected in "MP/INVERTER/SERVO Ethernet" 
in system configuration.

"1 System Configuration" (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device 
(memory) of the External Device. When synchronized, you can use the External Device’s 
ladder program to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System 
Area] Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Communication Settings

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MPE720) to set up communication settings for the communication module 218IF-01.

For details on communication settings, please refer to the manual of the External Device.

The setup procedure differs depending on the version of your ladder software.

Ladder Software Setting (for MPE720 Ver.5)

1 Start the ladder software, and in the root folder make the order and PLC folders.

2 Right-click the generated External Device, and from the shortcut menu select Logon.

3 From the PLC folder, double-click the [Definition folder]’s [Module Configuration] to display the [Engineering 

Manager].

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Double-click "No.1" and set up serial communication.

Serial communication is used to transfer communication settings to the PLC.

7 Save the settings and exit [Engineering Manager].

8 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

9 Transfer the settings to the communication module.

10 While online, logon to the External Device. Write the transferred data to FLASH memory.

11 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

• In the shortcut menu, please confirm there is no check mark beside the [Online] command 

before logging on.

• For methods on logging on, refer to the User's Manual of the External Device.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank. 
Communication is not possible when a connection parameter is set.
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Ladder Software Setting (for MPE720 Ver.6)

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Double-click "No.1" and set up serial communication.

Serial communication is used to transfer communication settings to the PLC.

7 Save the settings and exit [Engineering Manager].

8 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

9 Write the settings to the communication module.

10 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank.
Communication is not possible when a connection parameter is set.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MPE720) to set up communication settings for the communication module CPU unit.

For details on communication settings, please refer to the manual of the External Device.

The setup procedure differs depending on the version of your ladder software.

Ladder Software Setting (for MPE720 Ver.5)

1 Start the ladder software, and in the root folder make the order and PLC folders.

2 Right-click the generated External Device, and from the shortcut menu select Logon.

3 From the PLC folder, double-click the [Definition folder]’s [Module Configuration] to display the [Engineering 

Manager].

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Transfer the settings to the communication module.

9 While online, logon to the External Device. Write the transferred data to FLASH memory.

10 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

• In the shortcut menu, please confirm there is no check mark beside the [Online] command 

before logging on.

• For methods on logging on, refer to the User's Manual of the External Device.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank. 
Communication is not possible when a connection parameter is set.
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Ladder Software Setting (for MPE720 Ver.6)

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Write the settings to the communication module.

9 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank.
Communication is not possible when a connection parameter is set.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MPE720) to set up communication settings for the communication module 218IF-01.

For details on communication settings, please refer to the manual of the External Device.

The setup procedure differs depending on the version of your ladder software.

Ladder Software Setting (for MPE720 Ver.5)

1 Start the ladder software, and in the root folder make the order and PLC folders.

2 Right-click the generated External Device, and from the shortcut menu select Logon.

3 From the PLC folder, double-click the [Definition folder]’s [Module Configuration] to display the [Engineering 

Manager].

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Transfer the settings to the communication module.

9 While online, logon to the External Device. Write the transferred data to FLASH memory.

10 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

• In the shortcut menu, please confirm there is no check mark beside the [Online] command 

before logging on.

• For methods on logging on, refer to the User's Manual of the External Device.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank. 
Communication is not possible when a connection parameter is set.
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Ladder Software Setting (for MPE720 Ver.6)

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Write the settings to the communication module.

9 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank.
Communication is not possible when a connection parameter is set.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MPE720) to set up communication settings for the communication module 218IF-01.

For details on communication settings, please refer to the manual of the External Device.

The setup procedure differs depending on the version of your ladder software.

Ladder Software Setting (for MPE720 Ver.5)

1 Start the ladder software, and in the root folder make the order and PLC folders.

2 Right-click the generated External Device, and from the shortcut menu select Logon.

3 From the PLC folder, double-click the [Definition folder]’s [Module Configuration] to display the [Engineering 

Manager].

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Transfer the settings to the communication module.

9 While online, logon to the External Device. Write the transferred data to FLASH memory.

10 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

• In the shortcut menu, please confirm there is no check mark beside the [Online] command 

before logging on.

• For methods on logging on, refer to the User's Manual of the External Device.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank. 
Communication is not possible when a connection parameter is set.
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Ladder Software Setting (for MPE720 Ver.6)

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Engineering Manager]’s [Controller], use the pull-down menu to select the rack classification and 

communication module.

Set the number associated with the slot number used by the communication module.

When you select the communication module, its setting information is displayed in the [Engineering Manager]’s 

[Module details].

5 In the in [Module details], double-click the No. field’s numeric portion.

Double-click the number associated with the slot number connected to the Ethernet unit.

6 Save the settings and exit [Engineering Manager].

7 After turning ON the communication module’s "INIT" DIP Switch, turn ON the power supply.

8 Write the settings to the communication module.

9 Turn OFF the External Device’s power supply, turn OFF the "INIT" DIP Switch, and turn the External Device’s 

power back ON.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

Transmission parameter This Station IP address PLC  IP address

• Please make the connection parameter blank.
Communication is not possible when a connection parameter is set.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.

• To connect -V Series using a 1:n connection, [Wait To Send] must be 100ms or 
more.
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 Settings of External Device

Set communication settings for both MP and -V Series.

MP Series Setting

Use the ladder software (MPE720) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Create new file] dialog box, click [OK].

5 In the [Engineering Manager]’s [Controller], use the pull-down menu to select MECHATROLINK connection 

module.

Select the number associated with the slot number used by the module.

When you select the MECHATROLINK connection module, its setting information is displayed in the 

[Engineering Manger]’s [Module details].

6 In the [module Details]’s [Circuit Number] field, enter "01".

Set up the same value as the Display’s circuit number.

7 In [Details], double-click [MECHATROLINK].

8 Click the [Link Assignments] tab, and then set [ST#]’s [01] field as follows.

9 In the [Engineering Manager]’s [Controller], select CPU.

10 In the [Module details], double-click the communication module’s No. field.

11 Set [Transmission Parameters] as follows.

12 From the [File] menu select [Save] to save your settings, and exit [Engineering Manager].

13 Write the settings to the MP Series.

Setup Items Setup Description

TYPE Select the type of -V Series you are using.

• [ST#] is defined based on the -V Series station address. 

When the station address is 41H, define "ST#01".

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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-V Series Setting

Set up communication settings with the DIP Switch (SW2) and the rotary switch (SW1).  For example, when the 

SW2-3 is OFF and SW1 is 1, the station address is 41H.

For details on communication settings, please refer to the manual for the External Device.

• DIP Switch (SW2) Setting

• Rotary Switch (SW1) Setting

Set the station address in combination with the DIP Switch (SW2), number 3.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

DIP Switch Settings Setup Description

1 ON Communication speed: 10Mbps (MECHATROLINK-II)

2 Optional
Data transfer size.
ON: 32-byte data transfer
OFF: 17-byte data transfer

3 OFF
Define the station address in combination with the rotary switch (SW1).
ON: Tenth’s position of station address is 0x5
OFF: Tenth’s position of station address is 0x4

4 OFF Always OFF

Rotary Switch Settings Setup Description

SW1 1 Ones place of the station address
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3.6 Setting Example 6

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.

• To connect -V Series using a 1:n connection, [Wait To Send] must be 100ms or 
more.
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 Settings of External Device

Set communication settings for both MP and -V Series.

MP Series Setting

Use the ladder software (MPE720) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Create new file] dialog box, click [OK].

5 In the [Engineering Manager]’s [Controller], use the pull-down menu to select MECHATROLINK connection 

module.

Select the number associated with the slot number used by the module.

When you select the MECHATROLINK connection module, its setting information is displayed in the 

[Engineering Manger]’s [Module details].

6 In the [module Details]’s [Circuit Number] field, enter "01".

Set up the same value as the Display’s circuit number.

7 In [Details], double-click [MECHATROLINK].

8 Click the [Link Assignments] tab, and then set [ST#]’s [01] field as follows.

9 In the [Engineering Manager]’s [Controller], select CPU.

10 In the [Module details], double-click the communication module’s No. field.

11 Set [Transmission Parameters] as follows.

12 From the [File] menu select [Save] to save your settings, and exit [Engineering Manager].

13 Write the settings to the MP Series.

Setup Items Setup Description

TYPE Select the type of -V Series you are using.

• [ST#] is defined based on the -V Series station address. 

When the station address is 41H, define "ST#01".

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box. 
If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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-V Series Setting

Set up communication settings with the DIP Switch (SW2) and the rotary switch (SW1).  For example, when the 

SW2-3 is OFF and SW1 is 1, the station address is 41H.

For details on communication settings, please refer to the manual for the External Device.

• DIP Switch (SW2) Setting

• Rotary Switch (SW1) Setting

Set the station address in combination with the DIP Switch (SW2), number 3.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

DIP Switch Settings Setup Description

1 ON Communication speed: 10Mbps (MECHATROLINK-II)

2 Optional
Data transfer size.
ON: 32-byte data transfer
OFF: 17-byte data transfer

3 OFF
Define the station address in combination with the rotary switch (SW1).
ON: Tenth’s position of station address is 0x5
OFF: Tenth’s position of station address is 0x4

4 OFF Always OFF

Rotary Switch Settings Setup Description

SW1 1 Ones place of the station address
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3.7 Setting Example 7

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.

• To connect -V Series using a 1:n connection, [Wait To Send] must be 100ms or 
more.
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 Settings of External Device

Set communication settings for both MP and -V Series.

MP Series Setting

Use the ladder software (MPE720) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Create new file] dialog box, click [OK].

5 In the [Engineering Manager]’s [Controller], use the pull-down menu to select MECHATROLINK connection 

module.

Select the number associated with the slot number used by the module.

When you select the MECHATROLINK connection module, its setting information is displayed in the 

[Engineering Manger]’s [Module details].

6 In the [module Details]’s [Circuit Number] field, enter "01".

Set up the same value as the Display’s circuit number.

7 In [Details], double-click [MECHATROLINK].

8 Click the [Link Assignments] tab, and then [ST#]’s [01] as follows.

9 In the [Engineering Manager]’s [Controller], select CPU.

10 In the [Module details], double-click the communication module’s No. field.

11 Set [Transmission Parameters] as follows.

12 From the [File] menu select [Save] to save your settings, and exit [Engineering Manager].

13 Write the settings to MP Series.

Setup Items Setup Description

ADR 03H

ExADR 00

VENDOR Yaskawa Electric co.

DEVICE -V Series type

• [PROFILE], [BYTE] and [SCAN] are defined automatically.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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3.8 Setting Example 8

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.

• To connect -V Series using a 1:n connection, [Wait To Send] must be 100ms or 
more.
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 Settings of External Device

Set communication settings for both MP and -V Series.

MP Series Setting

Use the ladder software (MPE720) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file.

3 From the tree view, double-click [Module Configuration].

[Engineering Manager] starts.

4 In the [Create new file] dialog box, click [OK].

5 In the [Engineering Manager]’s [Controller], use the pull-down menu to select MECHATROLINK connection 

module.

Select the number associated with the slot number used by the module.

When you select the MECHATROLINK connection module, its setting information is displayed in the 

[Engineering Manger]’s [Module details].

6 In the [module Details]’s [Circuit Number] field, enter "01".

Set up the same value as the Display’s circuit number.

7 In [Details], double-click [MECHATROLINK].

8 Click the [Link Assignments] tab, and then [ST#]’s [01] as follows.

9 In the [Engineering Manager]’s [Controller], select CPU.

10 In the [Module details], double-click the communication module’s No. field.

11 Set [Transmission Parameters] as follows.

12 From the [File] menu select [Save] to save your settings, and exit [Engineering Manager].

13 Write the settings to MP Series.

Setup Items Setup Description

ADR 03H

ExADR 00

VENDOR Yaskawa Electric co.

DEVICE -V Series type

• [PROFILE], [BYTE] and [SCAN] are defined automatically.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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3.9 Setting Example 9

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set the Display's IP address in its offline mode.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file.

3 Click [Module Configuration] to start [MC-Configurator].

4 Double-click [218IFD] on the CPU you want to use.

5 Click the [Transmission Parameters] tab.

6 In the [Transmission Parameters], set the [IP Address] and [Subnet Mask].

7 Write the settings to the External Device.

8 Turn ON the External Device again.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0
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3.10 Setting Example 10

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set the Display's IP address in offline mode.
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 Settings of External Device

For details on communication settings, please refer to the manual of the External Device.

Setup Procedure

1 Press UP to display the Parameter Setting Mode screen. Press ENTER to change to Set Up Mode.

2 Press UP to display setup items. Press ENTER key to change to setup screen.

3 Press UP or RESET to select the setup value. Press ENTER to set up a description.

Setup Description

Setup Items Setup value Description

b1-02*1

*1 Set b1-01 to 3 when you set the frequency via MECHATROLINK.

3 Run Command Selection (Option Card)

F60-20 21 MECHATROLINK station address

F60-22 0 MECHATROLINK link rate (10Mbps)
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3.11 Setting Example 11

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set the Display's IP address in offline mode.
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 Settings of External Device

For details on communication settings, please refer to the manual of the External Device.

Setup Procedure

1 Press UP to display the Parameter Setting Mode screen. Press ENTER to change to Set Up Mode.

2 Press UP to display setup items. Press ENTER key to change to setup screen.

3 Press UP or RESET to select the setup value. Press ENTER to set up a description.

Setup Description

Setup Items Setup value Description

b1-02*1

*1 Set b1-01 to 3 when you set the frequency via MECHATROLINK.

3 Run Command Selection (Option Card)

F60-20 21 MECHATROLINK station address

F60-22 0 MECHATROLINK link rate (10Mbps)
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3.12 Setting Example 12

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the module number corresponding to the option slot which attaches MPU-01 in the [MC-

Configurator]

8 Select [MPU-01] in the [Module] dialog box, and click [OK].

9 Set "3" to the circuit number of MPU-01 that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.13 Setting Example 13

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings. Set the next contents.

(1) Main CPU settings

(2) MPU-01 settings

(3) -Vseries settings

For details on communication settings, please refer to the manual of the External Device.

Main CPU Settings

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the module number corresponding to the option slot which attaches MPU-01 in the [MC-

Configurator]

8 Select [MPU-01] in the [Module] dialog box, and click [OK].

9 Set "3" to the circuit number of MPU-01 that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

MPU-01 Settings

1 Start the ladder software.

2 Make a project file. Select "MPU-01" from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Expand [SVC] of [MPU-01] module, and double-click [01 UNDEFINED].

5 Select the using -V series of [Slave] dialog box, and click [OK].

6 Set "1" to the circuit number of [SVC].

7 Set  "3" to the station address of the added V-series.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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8 Write the settings to the MPU-01 series.

-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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3.14 Setting Example 14

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings. Set the next contents.

(1) Main CPU settings

(2) MPU-01 settings

(3) -Vseries settings

For details on communication settings, please refer to the manual of the External Device.

Main CPU Settings

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the module number corresponding to the option slot which attaches MPU-01 in the [MC-

Configurator]

8 Select [MPU-01] in the [Module] dialog box, and click [OK].

9 Set "3" to the circuit number of MPU-01 that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

MPU-01 Settings

1 Start the ladder software.

2 Make a project file. Select "MPU-01" from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Expand [SVC] of [MPU-01] module, and double-click [01 UNDEFINED].

5 Select the using -V series of [Slave] dialog box, and click [OK].

6 Set "1" to the circuit number of [SVC].

7 Set  "3" to the station address of the added V-series.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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8 Write the settings to the MPU-01 series.

-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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3.15 Setting Example 15

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings.

For details on communication settings, please refer to the manual of the External Device.

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the number of module which attaches a sub CPU in [MC-Configurator].

8 Select a sub CPU to be used in the [Module] dialog box, and click [OK].

9 Set "5" to the circuit number of Sub CPU that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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3.16 Setting Example 16

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings. Set the next contents.

(4) Main CPU settings

(5) Sub CPU settings

(6) -Vseries settings

For details on communication settings, please refer to the manual of the External Device.

Main CPU Settings

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the number of module which attaches a sub CPU in [MC-Configurator].

8 Select a sub CPU to be used in the [Module] dialog box, and click [OK].

9 Set "5" to the circuit number of Sub CPU that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

Sub CPU Settings

1 Start the ladder software.

2 Make a project file. Select a Sub CPU to be used from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Expand [SVC] of Sub CPU, and double-click [01 UNDEFINED].

5 Select the using -V series of [Slave] dialog box, and click [OK].

6 Set "1" to the circuit number of [SVC].

7 Set  "3" to the station address of the added V-series.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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8 Write the settings to the Sub CPU.

-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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3.17 Setting Example 17

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device address in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in the offline mode of the Display.
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 Settings of External Device

Use the ladder software (MP720 Ver.7) to set up communication settings. Set the next contents.

(1) Main CPU settings

(2) Sub CPU settings

(3) -Vseries settings

For details on communication settings, please refer to the manual of the External Device.

Main CPU Settings

1 Start the ladder software.

2 Make a project file. Select the main CPU models from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Double-click [218IFD] on the CPU to use.

5 Click [Parameters] tab.

6 Set "IP Address" and "Subnet Mask" of "Transmission Parameters".

7 Double-click the number of module which attaches a sub CPU in [MC-Configurator].

8 Select a sub CPU to be used in the [Module] dialog box, and click [OK].

9 Set "5" to the circuit number of Sub CPU that displayed in the [MC-Configurator].

Set up the same value as the Display’s circuit number.

10 Write the settings to the External Device.

Sub CPU Settings

1 Start the ladder software.

2 Make a project file. Select a sub CPU to be used from [Model].

3 From the tree view, double-click [Module Configuration].

[MC-Configurator] starts.

4 Expand [SVC] of Sub CPU, and double-click [01 UNDEFINED].

5 Select the using -V series of [Slave] dialog box, and click [OK].

6 Set "1" to the circuit number of [SVC].

7 Set  "3" to the station address of the added V-series.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.
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8 Write the settings to the Sub CPU.

-V Series Setting

Set up communication settings with rotary switches (S1 and S2).

For details on communication settings, please refer to the manual of the External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• To write the settings, select the [Save to flash after transferring to the controller] check 
box.
 If the data is transferred without selecting the check box, the transferred data is 
deleted when restarting the External Device.

Rotary Switch Settings Setup Description

S1 (x16) 0
Station address

S2 (x1) 3
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4 Setup Items

Set up the Display’s communication settings in GP Pro-EX or in the Display’s offline mode.

The setting of each parameter must match that of the External Device.

"3 Communication Settings" (page 13)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in offline mode.

Cf. Maintenance/Troubleshooting Guide "Ethernet Settings"

Setup Items Setup Description

Port No.
Enter a port number of the External Device, using 1024 to 65535. Check into [Auto], and a 
port number is set automatically.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response 
from External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Increase Allowable 
Number of Devices/
PLCs

When clicked, the [Increase Allowable Number of Devices/PLCs] dialog box is displayed.
When you check [Increase allowable number of Devices/PLCs], the settings for 
[Allowable Number of Devices/PLCs] can be extended to "64".

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Setup Items Setup Description

Product Select the product name of the External Device.

Connect to MPU-01 / 
Connect to Sub CPU

Uncheck the check box when communicating with MP2000 series / MP3000 series.

IP Address 

Set IP address of the External Device.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

MP2000 Series MP3000 Series
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Setup Items Setup Description

Product Select the product name of the External Device.

Connect to MPU-01 / 
Connect to Sub CPU

Check the check box when using MPU-01 and Sub CPU.

Uncheck the check box when using an Ethernet port on the Sub CPU.

Relay IP Address

Set IP address of the relay device (MP Series).

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Device Type Select a device type to be used for relay.

Circuit No. Enter the circuit number, from 1 to 16.

MPU-01 Sub CPU
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Setup Items Setup Description

Product Select the product name of the External Device.

Series Select the series of the External Device.

Relay IP Address

Set IP address of the relay device (MP Series).

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Device Type Select a device type to be used for relay.

Circuit No. Enter the circuit number, from 1 to 16.

Station No.

Inverter Series: Enter the station number, from 1 to 255.
-V Series: Enter the station number as follows.
 MECHATROLINK-II: "65 to 79" and "80 to 95"
 MECHATROLINK-III: "3 to 239"

• When communicating with the -V Series, the first three octets in the subnet mask 

should be set to 255.

e.g.: 255.255.255.0

Inverter Series -V Series
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4.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Please refer to Maintenance/Troubleshooting Guide for more information on how to enter 

offline mode or about operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"
• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No.

Enter a port number of the Display.
Select either of "Fixed" "Auto". Enter a port number of the Display with "1024-65535", 
when select "Fixed". Assign automatically without affecting the input value, when select 
"Auto".

Timeout
Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response 
from External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
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Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list, and touch [Device].

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of the External Device 
set with GP-Pro EX. (Initial value [PLC1])

Series Display the series of the External Device.

IP Address

Set IP addresses used by the External Device or relay device (MP Series).

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.
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5 Supported Devices

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your connecting equipment.

5.1 MP2000 Series / MPU-01

 This address can be specified as system data area.         

5.2 MP3000 Series / Sub CPU

 This address can be specified as system data area.         

Device Bit Address Word Address
32

bits
Notes

System registers SB000000 - SB08191F SW00000 - SW08191

Input registers IB00000 - IBFFFFF IW0000 - IWFFFF *1

*1 As for Input and Output registers, device 0x9000-0xFFFF cannot be written.

Output registers OB00000 - OBFFFFF OW0000 - OWFFFF *1

Data registers MB000000 - MB65534F MW00000 - MW65534

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

Device Bit Address Word Address
32

bits
Notes

System registers SB000000 - SB65534F SW00000 - SW65534

Input registers IB000000 - IB27FFFF IW00000 - IW27FFF *1

*1 As for Input and Output registers, device 0x9000-0xFFFF cannot be written.

Output registers OB000000 - OB27FFFF OW00000 - OW27FFF *1

Data registers
MB00000000 - 
MB1048575F

MW0000000 - 
MW1048575

G registers
GB000000000 - 
GB02097151F

GW00000000 - 
GW02097151

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.3 Inverter Series

 This address can be specified as system data area.         

Device Bit Address Word Address
32

bits
Notes

Bit registers*1

*1 In the Inverter, bit registers and registers use the same device. Bit registers are used only for bit                 
addresses.
The access method when specifying bits varies depending on the device.

Bit registers.................................BR0000.0 - BR195C.F

Registers .....................................

BR0000.0 - BR195C.F - - *2

*2 The available register numbers and available read/write operations differ depending on the           
External Device model. For further information, refer to the instruction manual for your External             
Device.

Registers*1 - 0000~195C  *2

• You can only set the Read Area Size for the system area in the External Device. Please refer 

to the GP-Pro EX Reference Manual for Read Area Size.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.4 -V Series

 This address can be specified as system data area.         

Device Bit Address Word Address
32

bits
Notes

Normal Parameters Area 0000.0 - 0FFF.F 0000 - 0FFF *1  *2

*1 When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the                   
new word value to the External Device. If the ladder program writes data to this word address during the bit                   
write process, the resulting data may be incorrect.

*2 The following addresses are 32 bit parameters. Please use two words when reading or writing.

Temporary Parameters Area 1000.0 - 1FFF.F 1000 - 1FFF *1  *2

Monitor Area E000.0 - EFFF.F E000 - EFFF *1  *2

• You can only set the Read Area Size for the system area available to use in the External 

Device. Please refer to the GP-Pro EX Reference Manual for Read Area Size.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

• Normal Parameters Area
020AH / 020EH / 0210H / 0212H / 0282H / 051BH / 0520H / 0522H / 0524H / 0526H / 0531H /
0804H / 0806H / 0808H / 0814H / 0819H / 0820H / 0822H / 0834H / 0836H / 0838H / 083AH /
083CH / 083EH / 0840H / 0890H / 0892H / 0894H / 0896H / 0898H / 089AH / 089CH / 089EH /
08A0H / 08A2H / 08A4H / 08A6H / 08A8H / 08AAH / 08ACH / 08AEH / 08B0H / 08B2H / 08B4H /
08B6H / 08B8H / 08BAH / 08BCH / 08BEH / 0A02H / 0A04H / 0A06H / 0A08H / 0A0AH / 0A0CH /
0A0EH / 0A10H / 0A12H / 0A14H / 0A16H / 0A18H / 0A42H / 0A44H / 0A46H / 0A48H / 0A4AH /
0A4CH / 0A4EH / 0A50H / 0A52H / 0A82H / 0A84H / 0A86H / 0A88H / 0A8AH / 0A8CH / 0A8EH /
0A90H / 0A92H / 0AC2H / 0AC4H / 0AC6H / 0AC8H / 0ACAH / 0ACCH / 0ACEH / 0B02H / 0B04H /
0B06H / 0B08H / 0B0AH / 0B0CH / 0B0EH / 0B10H / 0B12H / 0B14H / 0B16H / 0B18H / 0B1AH /
0B1CH / 0B1EH / 0B20H / 0B22H / 0B24H / 0B26H /

• Temporary Parameters Area
120AH / 120EH / 1210H / 1212H / 1282H / 151BH / 1520H / 1522H / 1524H / 1526H / 1531H /
1804H / 1806H / 1808H / 1814H / 1819H / 1820H / 1822H / 1834H / 1836H / 1838H / 183AH /
183CH / 183EH / 1840H / 1890H / 1892H / 1894H / 1896H / 1898H / 189AH / 189CH / 189EH /
18A0H / 18A2H / 18A4H / 18A6H / 18A8H / 18AAH / 18ACH / 18AEH / 18B0H / 18B2H / 18B4H /
18B6H / 18B8H / 18BAH / 18BCH / 18BEH / 1A02H / 1A04H / 1A06H / 1A08H / 1A0AH / 1A0CH /
1A0EH / 1A10H / 1A12H / 1A14H / 1A16H / 1A18H / 1A42H / 1A44H / 1A46H / 1A48H / 1A4AH /
1A4CH / 1A4EH / 1A50H / 1A52H / 1A82H / 1A84H / 1A86H / 1A88H / 1A8AH / 1A8CH / 1A8EH /
1A90H / 1A92H / 1AC2H / 1AC4H / 1AC6H / 1AC8H / 1ACAH / 1ACCH / 1ACEH / 1B02H / 1B04H /
1B06H / 1B08H / 1B0AH / 1B0CH / 1B0EH / 1B10H / 1B12H / 1B14H / 1B16H / 1B18H / 1B1AH /
1B1CH / 1B1EH / 1B20H / 1B22H / 1B24H / 1B26H /

• Monitor Area
E003H / E009H / E00EH / E010H / E012H / E016H / E01BH / E084H / E52AH / E52CH / E52EH /
E530H / E532H / E534H / E536H / E538H / E53AH / E53CH / E601H / E603H / E605H / E707H
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 Normal Parameters Area

This area is used to map the External Device’s user constant parameters. The register number is defined by adding 

the Pn number and the offset value.  The normal parameters area offset value is 0000H.

For details on the Pn number and register mapping, please refer to the manual of the External Device.

 Temporary Parameters Area

This area is used to map the External Device’s user constant parameters. The register number is defined by adding 

the Pn number and the offset value.  The temporary parameters area offset value is 1000H.

For details on the Pn number and register mapping, please refer to the manual of the External Device.

Since writing to Temporary Parameters Area is run in volatile memory (such as RAM), values are cleared when 

the External Device is turned OFF.

If there is an operation, such as servo tuning, that requires an extreme number of write operations to memory, 

running the operation in the Temporary Parameters Area generates the following advantages.

• You can increase the life of non-volatile memory.

• You can reduce processing time.

Operation Description

Read
Reads volatile memory such as RAM for values. Unable to read values from non-volatile 
memory such as EEPROM.

Write Writes values to volatile memory such as RAM, and non-volatile memory such as EEPROM.

• You cannot run consecutive reads from, or consecutive writes to, different register groups.
Example: When consecutively reading from or writing to 07FFH to 0800H, the message "Data 
Consistency Error (33H)" or "Access Denied Error (31H)" is displayed.

• If you specify a nonexistent register number, the message "Access Denied Error (31H)," is 
displayed.

Operation Description

Read Reads volatile memory such as RAM for values.

Write Writes values to volatile memory such as RAM.

• You cannot run consecutive reads from, or consecutive writes to, different register groups.
Example: When consecutively reading from or writing to 07FFH to 0800H, the message "Data 
Consistency Error (33H)" or "Access Denied Error (31H)" is displayed.

• If you specify a nonexistent register number, the message "Access Denied Error (31H)," is 
displayed.
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 Monitor Area

This area is used to reference internal information (such as operating condition, alarm status, and various status 

flags) on the External Device. By referring to the value of a register number, you can check the status of the 

External Device. While the External Device is running, register values change constantly.

Register 

No.
Name Unit

No. of 

Registers
Sign Remarks

E000H Motor Rotational/Translational Speed
Rotary: min-1

1 S Un000
Linear: mm/s

E001H Reference Speed
Rotary: min-1

1 S Un001
Linear: mm/s

E002H Internal Torque/Thrust Force Reference % 1 S Un002

E003H
Rotational Angle 1 
(Number of Pulses from the Origin)

Pulse 2 U Un003

E005H
Rotational Angle 2 
(Angle from the Origin)

deg 1 U Un004

E006H Input Signal Monitor - 1 - Un005

E007H Output Signal Monitor - 1 - Un006

E008H Input Reference Pulse Speed
Rotary: min-1

1 S Un007
Linear: mm/s

E009H Position Error Counter Reference unit 2 S Un008

E00BH Accumulated Load Rate %(10s cycle) 1 U Un009

E00CH Regenerative Load Rate %(10s cycle) 1 U Un00A

E00DH Dynamic Break Consumption Power %(10s cycle) 1 U Un00B

E00EH Input Reference Pulse Counter (32bit) Pulse 2 S Un00C

E010H Feedback Pulse Counter (32bit) Pulse 2 S Un00D

E012H
Fully-closed Feedback Pulse Counter 
(32bit)

Pulse 2 S Un00E

E016H Total Operation Time 100ms 2 U Un012

E018H Upper Limit of Maximum Motor Speed mm/s 1 U
Un010 
(Available only in 
linear motor)

E019H
Upper Limit of Divided Pulse Output 
Setting

Pulse/Pitch 1 U
Un010
(Available only in 
linear motor)

E01AH Magnetic Pole Sensor Information - 1 - Un011

E01BH Feedback Pulse Counter Reference unit 2 S Un013

E01DH Effective Gain Set Number - 1 U Un014

E01EH Safety I/O Signal Monitor - 1 - Un015

E084H Linear Scale Pitch pm 2 U Un084

E086H Linear Scale Pitch Scaling Exponent Power of Ten 1 S Un085
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E500H Alarm History Alarm Code No. = 0 Code 1 U Fn000-0

E501H Alarm History Alarm Code No. = 1 Code 1 U Fn000-1

E502H Alarm History Alarm Code No. = 2 Code 1 U Fn000-2

E503H Alarm History Alarm Code No. = 3 Code 1 U Fn000-3

E504H Alarm History Alarm Code No. = 4 Code 1 U Fn000-4

E505H Alarm History Alarm Code No. = 5 Code 1 U Fn000-5

E506H Alarm History Alarm Code No. = 6 Code 1 U Fn000-6

E507H Alarm History Alarm Code No. = 7 Code 1 U Fn000-7

E508H Alarm History Alarm Code No. = 8 Code 1 U Fn000-8

E509H Alarm History Alarm Code No. = 9 Code 1 U Fn000-9

E50AH Current Alarm Information Code 1 U

E51BH Servo Running Status - 1 U

E51CH Control Mode Status - 1 U

E52AH Alarm History Time Stamp No. = 0 100ms 2 U

E52CH Alarm History Time Stamp No. = 1 100ms 2 U

E52EH Alarm History Time Stamp No. = 2 100ms 2 U

E530H Alarm History Time Stamp No. = 3 100ms 2 U

E532H Alarm History Time Stamp No. = 4 100ms 2 U

E534H Alarm History Time Stamp No. = 5 100ms 2 U

E536H Alarm History Time Stamp No. = 6 100ms 2 U

E538H Alarm History Time Stamp No. = 7 100ms 2 U

E53AH Alarm History Time Stamp No. = 8 100ms 2 U

E53CH Alarm History Time Stamp No. = 9 100ms 2 U

Register 

No.
Name Unit

No. of 

Registers
Sign Remarks
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• Input Signal Monitor (E006H)

MECHATROLINK Interface Type

• Output Signal Monitor (E007H)

MECHATROLINK Interface Type

Bit Status Signal Logic Un No.

0 SI0(CN1-13)
0 = Lo (Close)
1 = Hi (Open)

Un005

1 SI1(CN1-7)
0 = Lo (Close)
1 = Hi (Open)

2 SI2(CN1-8)
0 = Lo (Close)
1 = Hi (Open)

3 SI3(CN1-9)
0 = Lo (Close)
1 = Hi (Open)

4 SI4(CN1-10)
0 = Lo (Close)
1 = Hi (Open)

5 SI5(CN1-11)
0 = Lo (Close)
1 = Hi (Open)

6 SI6(CN1-12)
0 = Lo (Close)
1 = Hi (Open)

7 Reserved

Bit Status Signal Logic Un No.

0 ALM(CN1-3,4)
0 = Lo (Close)
1 = Hi (Open)

Un006

1 SO1(CN1-1,2)
0 = Lo (Close)
1 = Hi (Open)

2 SO2(CN1-23,24)
0 = Lo (Close)
1 = Hi (Open)

3 SO3(CN1-25,26)
0 = Lo (Close)
1 = Hi (Open)

4 Reserved

5 Reserved

6 Reserved

7 Reserved
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• Safety I/O Signal Monitor (E01EH)

• Servo Running Status (E51BH)

• Control Mode Status (E51CH)

Bit Status Signal Logic Un No.

0 /HWBB1(CN8-3,4)
0 = Lo (Close)
1 = Hi (Open)

Un015
1 /HWBB2(CN8-5,6)

0 = Lo (Close)
1 = Hi (Open)

2 to 7 Reserved

• /HWBB1 and /HWBB2 are valid only when the safety option card is not connected.  When the 

safety option card is connected, they become indefinite.

Reading Description

0000H Reserved (Initial State)

0001H Alarm Occurred (A.***)

0002H Hardwired Base Blocked (HWBB)

0003H Forward / Reverse Run Prohibited (PTNT)

0004H Forward Run Prohibited (P-OT)

0005H Reverse Run Prohibited (N-OT)

0006H Base Blocked (BB)

0007H Base Enabled (RUN)

0008H Magnetic Pole Detecting (PDET)

Reading Description

0000H Speed Control Mode

0001H Position Control Mode

0002H Torque Control Mode

• JOG Drive Mode, Origin Search Mode, and Internally Set Speed Control Mode become Speed 

control mode.

• Programmed JOG Drive Mode, Advanced Auto-Tuning Mode, and Easy FFT Mode become 

Position Control Mode.
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6 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

6.1 MP2000 Series / MPU-01

6.2 MP3000 Series / Sub CPU

6.3 Inverter Series

6.4 -V Series

Device Device Name
Device Code

(HEX)
Address Code

System registers SW/SB 0080 Word address

Input registers IW/IB 0001 Word address

Output registers OW/OB 0081 Word address

Data registers MW/MB 0000 Word address

Device Device Name
Device Code

(HEX)
Address Code

System registers SW/SB 0080 Word address

Input registers IW/IB 0001 Word address

Output registers OW/OB 0081 Word address

Data registers MW/MB 0000 Word address

G registers GW/GB 0002 Word address

Device Device Name
Device Code

(HEX)
Address Code

Bit registers BR 0080 Address

Registers - 0000 Address

Device Device Name
Device Code

(HEX)
Address Code

Normal Parameters Area 0 0000 Word address

Temporary Parameters 
Area

1 0001 Word address

Monitor Area E 0009 Word address
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX.((Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Please refer to the manual of External Device for more detail of received error codes.

• Please refer to "Display-related errors" of "Maintenance/Troubleshooting Guide" for a 

common error message to the driver.
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7.1 MP Series

 Error Codes Unique to External Device

 Error Messages Unique to External Device

Error code Description

0x90 Transfer error.

0x92 Illegal parameter.

0x96 Register No. over.

0x9C File is modified.

0x9D Data access error.

Message ID Error Message Description

RHxx128 "(Node Name):PLC is busy now(Error Code: [Hex])" PLC is "Busy"

RHxx129 "(Node Name):Option module is not mounted(Error Code: [Hex])" Option module not mount.

RHxx130 "(Node Name):Module is not ready(Error Code: [Hex])" Module is not ready

RHxx131 "(Node Name):CPU is stopped(Error Code: [Hex])" CPU is stopped

RHxx132 "(Node Name): Write protected(Error Code: [Hex])" Write protected
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7.2 Inverter Series

 Error Codes Unique to External Device

 Error Messages Unique to External Device

Error code Description

0x01 Function code error

0x02 Invalid register number error

0x03 Invalid quantity error

0x21 Date setting error

0x22 Write mode error

0x23 Main circuit undervoltage (UV) error during write

0x24 Write error during processing of constants

Message ID Error Message Description

RHxx133
"(Node Name): The Series and Device Type is not correct. 
Connecting via (MECHATROLINK-II or 
MECHATROLINK-III)"

This message appears when the 
connected Device Type does not 
match the Inverter Series selected 
in offline mode.
Check the Device Type.
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7.3 -V Series

 Error Codes Unique to External Device

 Error Messages Unique to External Device

Error code Description

0x01
Function Code Error
• Unsupported function code or sub function code.

0x02
Faulty Register Number
• Accessing register number that is not registered.

0x03

Faulty Quantity
• The number of read or write data for reading is not between one and the maximum 

quantity (as defined per model).
• In write mode, the number of data in the message is not the specified quantity.

0x30
Faulty Register Number (High Level)
• Accessing register number that is not registered.

0x31
Access Limit Error
• Access to the specified register is not permitted.

0x32
Outside Setting Range Error
• The write data value is outside the maximum and minimum limit.

0x33
Data Matching Error
• Tried to access only a portion of registers in the multiple register unit.
• Tried to access multiple registers that exceed the register group.

0x34
Condition Error
• Command message content cannot be processed due to the condition defined by the 

register.

0x35
Process Conflict Error
• Cannot be processed due to priority issues with other channels.

Message ID Error Message Description

RHxx133
"(Node Name): The Series and Device Type is not correct. 
Connecting via (MECHATROLINK-II or 
MECHATROLINK-III)"

This message is displayed when the 
connected Device Type does not 
match the -V Series selected in 
offline mode.
Check the Device Type.
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